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Legal Notices
Trademarks
Canon and Canon logo are trademarks of Canon Inc.
Microsoft, Windows and Windows Server are registered trademarks of Microsoft Corporation in the United States and other countries.
Windows Vista is a trademark of Microsoft Corporation in the United States and other countries.
All other product and brand names are registered trademarks, trademarks or service marks of their respective owners.
Copyright
Copyright © 2009 by Canon Inc. All rights reserved. No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval
system, or translated into any language or computer language in any form or by any means, electronic, mechanical, magnetic, optical, chemical,
manual, or otherwise, without the prior written permission of Canon Inc.
Disclaimers
The information in this document is subject to change without notice.
CANON INC. MAKES NO WARRANTY OF ANY KIND WITH REGARD TO THIS MATERIAL, EITHER EXPRESS OR IMPLIED, EXCEPT AS
PROVIDED HEREIN, INCLUDING WITHOUT LIMITATION, THEREOF, WARRANTIES AS TO MARKETABILITY, MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE OF USE OR NON-INFRINGEMENT. CANON INC. SHALL NOT BE LIABLE FOR ANY DIRECT,
INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY NATURE, OR LOSSES OR EXPENSES RESULTING FROM THE USE OF THIS
MATERIAL.
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■ Using the Top Page
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Returns to the last page opened.
Displays the previous or next page.
Returns to the top page.
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How to Use This Guide

Displays the “How to Use This Guide” page.
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The following symbols are used throughout the manuals for the machine and indicate the warnings, cautions and notes you should
keep in mind when using the machine.
WARNING

Indicates a warning that may lead to death or serious injury if not observed.
CAUTION

Explains how to avoid actions that could injure you or damage your machine.
NOTE

4

Explains operating restrictions and how to avoid minor difficulties.

In addition, this guide uses a distinctive notation to identify buttons:
– Menu items you select and the buttons you press on the screen appear in square brackets: [Preferences].
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Where to Find Help
When you encounter a problem during installation of the
driver software or while operating your machine, consult
the following:

In This Manual
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See Chapter 3, “Troubleshooting.”

In the Basic Operation Guide
See Chapter 11, “Troubleshooting.”

In the Reference Guide
See Chapter 10, “Troubleshooting.”

Readme.txt File
The hints, limitations, and restrictions you need to be aware of
when using the ScanGear and MF Toolbox are included in the
Readme.txt file provided with these programs.
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System Requirements
General
– IBM or IBM-compatible PC
– PC equipped with a USB port and the USB class driver
installed
Microsoft Windows 98, 98SE
CPU: Intel® Pentium® 90 MHz or higher
Memory: 128 MB or more

NOTE

The USB 2.0 Hi Speed connection requires a PC equipped with a CPU
higher than Intel® Pentium® ll, more than 128 MB of RAM, and with
Windows Vista, Windows XP service pack released later than SP1 or
Windows 2000 SP4 installed. If your PC meets all of these
requirements and is preinstalled with USB 2.0 Host Controller, the USB
2.0 connection will be guaranteed.

Microsoft Windows Me
CPU: Intel® Pentium® 150 MHz or higher
Memory: 128 MB or more
Microsoft Windows 2000 Professional
CPU: Intel® Pentium® 133 MHz or higher (USB 1.1),
Intel® Pentium® II or higher (USB 2.0)
Memory: 128 MB or more
Microsoft Windows XP
CPU: Intel® Pentium®/Celeron® 300 MHz or higher (USB 1.1),
Intel® Pentium® II or higher (USB 2.0)
Memory: 128 MB or more
Microsoft Windows Vista
CPU: Intel® Pentium® 800MHz or faster
Memory: 512MB or more
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Checking Installation
Check if the driver is installed successfully.

1.

3

Open the [Scanners and Cameras] folder
(Windows 98/2000: the [Scanners and
Cameras Properties] dialog box).
Click [start] on the Windows task bar → select [Control Panel] →
[Printers and other Hardware] → [Scanners and Cameras].
(Windows Vista: [start] → [Control Panel] → [Hardware and
Sound] → [Scanners and Cameras]. Windows 98/Me/2000:
[Start] → [Settings] → [Control Panel] → double-click [Scanners
and Cameras].)
Make sure the corresponding scanner driver icon is displayed.
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NOTE

If the driver has not been installed on your computer, see
“Installing/Uninstalling Software” in the Starter Guide and install
it.

2.

If the [Canon MF Toolbox 4.9] icon is
displayed on the Windows desktop,
installation of the MF Toolbox 4.9 has been
successful.
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4

Setting up an application which has been
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Setting up other applications which have not been
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Scanning with [Start] on the Machine
You can scan documents and transmit the scanned data to
your computer using the operation panel of the machine.
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NOTE

Your machine must be connected via USB and the USB scanner driver
must be loaded to scan. This machine does not support network
scanning.

1.

Set documents.

2.

Press [SCAN] on the machine.

3.

Press [Start] on the machine.
If you are asked to select a program to launch, select “MF
Toolbox Ver4.9.” The scanned document will be processed
according to your settings.
When scanning is completed, a folder with the scanning date will
be created in the [My Pictures] folder in the [My Documents]
folder, and your document will be saved in this folder.(In VISTA,
the folder will be created in the [Pictures] folder.)
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Setting the Scanning Function for [Start]
When you scan for the first time using [Start] on the
machine, scanning will start in the same way as when you
click [Save] in the MF Toolbox. By following procedure
below you can change the set for scanning function on
each of MF Toolbox or other applications when you press
[start].

■ Setting up an application which has
been registered to MF Toolbox

1.

2.

Drag the
select.

The

mark over the button you want to

mark will be displayed above the button you select.

On the Windows desktop, double-click the
[Canon MF Toolbox 4.9] icon to open the MF
Toolbox.
You can also open the MF Toolbox by clicking [start] on the
Windows task bar → [(All) Programs] → [Canon] → [MF Toolbox
4.9] → [Toolbox 4.9].
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Also you can set it up in the following way.
In the MF Toolbox, click [Settings] to open the [Settings] dialog
box. From the drop-down list, select the scanning function you
want to link [Start] to, then click [OK].

3.

Select [Properties] from the [File] menu.
(Windows 98/2000/Vista: Click [Properties].)
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■ Setting up other applications which
have not been registered to MF Toolbox

1.

Open the [Scanners and Cameras] folder
(Windows 98/2000: the [Scanners and
Cameras Properties] dialog box).
Click [start] on the Windows task bar → select [Control Panel] →
[Printers and other Hardware] → [Scanners and Cameras].
(Windows Vista: [start] → [Control Panel] → [Hardware and
Sound] → [Scanners and Cameras]. Windows 98/Me/2000: [Start]
→ [Settings] → [Control Panel] → double-click [Scanners and
Cameras].)

2.

Click the corresponding scanner driver icon.
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4.

Specify an action for [Start].
On Windows XP/Vista:
Select the [Events] tab → select the option corresponding to your
machine from [Select an event] → select the operation for [Start]
in [Actions] → click [OK].

On Windows 98/Me/2000:
Select the [Events] tab → select the option corresponding to your
machine from [Scanner events] → select the operation for [Start]
in [Send to this application] → click [OK].
NOTE

If the settings you specified in the scanner property dialog box do not
work immediately, disconnect and reconnect the USB cable, or restart
your computer.
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Scanning with the MF Toolbox
You can scan a document using the buttons on the MF
Toolbox.

1.

Set documents.

2.

On the Windows desktop, double-click the
[Canon MF Toolbox 4.9] icon to open the MF
Toolbox.

4

A dialog box appears for each of the buttons.

You can also open the MF Toolbox by clicking [start] on the
Windows task bar → [(All) Programs] → [Canon] → [MF Toolbox
4.9] → [Toolbox 4.9].

3.

Click one of the scanning buttons.
[Mail]: The document will be scanned and attached to an e-mail
message in your e-mail application.

Example: [Mail] dialog box

[OCR]: The text will be scanned and read by the OCR software.
[Save]: The document will be scanned and saved.
[PDF]: The text will be scanned and saved as a PDF file.
[Scan-1], [Scan-2]: The text will be scanned and appear in the
registered application. You can change the button name by
directly entering a new name (up to 8 characters long) over the
button name.
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4.

For details, see “MF Toolbox Settings,” on p. 2-9.
If you want to keep the same settings for future scans, click
[Apply] before clicking [Start].

2
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With [Scan-1] and [Scan-2] buttons, you can set the different
settings for each. If you save the settings by clicking [Apply], the
settings will be effective next time.
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Specify the required settings.

5.

Click [Start].
If you select [Display the Scanner Driver] in step 4, the
[ScanGear MF] dialog box will appear.

6.

7.

Click [Scan].
When scanning is completed, a folder with the scanning date will
be created in the [My Pictures] folder in the [My Documents]
folder, and your document will be saved in this folder.(In VISTA,
the folder will be created in the [Pictures] folder.)
If you have applications registered to the [Mail], [OCR], [PDF],
[Scan-1], or [Scan-2] buttons, the scanned image will be
displayed in the application or attached to an e-mail message
after scanning. For details, see “External Program (Mail
Program),” on p. 2-13.
For some models, the CD-ROM provided with the machine
contains the application Presto! PageManager which can be
used with the MF Toolbox. Presto! PageManager will be
registered in the [OCR] and [PDF] buttons of the MF Toolbox at
the time of installation.

Specify the required settings.
For details, see “Setting Preferences and Scanning with
ScanGear MF,” on p. 2-18.
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MF Toolbox Settings
■ Scanner Settings

2

You can specify the scanning mode, resolution, document size,
and file size of the scanned image.
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[Select Source]
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Selects where the document is placed
([Platen Glass], [ADF], or [Auto Mode]).

NOTE

When [Auto Mode] is selected, the document in the ADF is
automatically scanned. If there is no document in the ADF, the
document on the platen glass will be scanned.

[Paper Size]

Selects the size of the document to be
scanned. Selecting [Custom] opens the
[Paper Size Settings] dialog box which
enables you to set the custom paper size.

Example: [Mail] dialog box
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[Orientation]

Opens the [Orientation] dialog box. This
dialog box enables you to specify the
orientation of the document.
This button is disabled when [Platen Glass]
is selected in [Select Source].

(Original Orientation)
Shows the direction of scanning paper. The
icon display varies depending on the
settings for [Select Source], [Paper Size],
and [Orientation].

[Scan Mode]

Selects the scan mode. The scan modes
you can select differ depending on the MF
Toolbox button you press.
[Black and White]:
Scans document as a black and white
image.
[Black and White (OCR)]:
Scans document as a black and white image
for OCR software.
[Grayscale]:
Scans document as a grayscale image
(similar to a monochrome picture).
[Color]:
Scans document as a color image.
[Color (Magazine)]:
Scans document as a color image with the
Descreen function, which enables you to
reduce the moire when scanning printed
photographs and pictures.
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[Upper Limit of Attached File]
Selects an approximate upper size limit
(after compression) for the image you will
send. For an ordinary mail message,
[150 KB] is recommended.
You can specify this item when scanning
using the [Mail] button and [JPEG/Exif] is
selected in [Save as Type].
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[Image Quality]

Selects the scan quality (resolution).
When scanning using the [Mail] button, the
resolution you can select depends on the
setting in [Upper Limit of Attached File].

[Display the Scanner Driver]
If you select this check box, all items in the
[Scanner Settings] become invalid, and
when [Start] is clicked the [ScanGear MF]
dialog box appears and enables you to make
advanced settings for scanning.
This check box is not available when
scanning using the [OCR] button.

[Save as Type]

Specifies the file type to save the scanned
image.
[BMP]:
Bitmap format.
[JPEG/Exif]:
JPEG/Exif format. This option is available
when [Grayscale], [Color] or [Color
(Magazine)] is selected in [Scan Mode].
[TIFF]:
TIFF format.
[PDF]:
PDF format.
[PDF (Multiple Pages)]:
Creates one PDF file from two or more
scanned pages (see “Creating One PDF File
from Two or More Pages,” on p. 2-16).
[PDF (Add Page)]:
Adds the scanned image to the last page of
an existing PDF file that was created with
the MF Toolbox.

■ Save Scanned Image to
You can specify the file name, file format, and location to save
the scanned image. If you select PDF as a file format, you can
also specify the detailed settings for the PDF file.
[File Name]

Enter a file name for the scanned image.
If you save another file with the same name,
four digits starting from 0001 will be attached
after the file name.
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[PDF Settings]

– The type of file which can be saved with each button is shown
below.

2
JPEG/
Exif

PDF

PDF

BMP

TIFF

PDF

(Multiple
Pages)

(Add
Page)

[Mail]

–

●

–

●

●

●

[OCR]

●

●

●

–

–

–

[Save]

●

●

●

●

●

●

[PDF]

–

–

–

●

●

●

[Scan-1],
[Scan-2]

●

●

●

–

–

–
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– When [PDF], [PDF (Multiple Pages)], or [PDF (Add Page)] is
selected and if an error message appears indicating that the
image size is too large, reduce the data size of the scanned
image. For details, see “Output Settings,” on p. 2-26.

Opens the [PDF Settings] dialog box which
enables you to make advanced settings of
the PDF file (see “Creating One PDF File
from Two or More Pages,” on p. 2-16).

[Save Scanned Image to]
Shows the location to save the scanned
images. To change the location, click
[Browse] → select a folder → click [OK].
[Add Scanned Image to]
This item appears instead of [Save Scanned
Image to] when [PDF (Add Page)] is
selected in [Save as Type]. You can select
the PDF file to which you want to add the
scanned image.
[Save Pictures to a Subfolder with Current Date]
Select this check box to create a folder with
current date (e.g. 2007-12-31) in the
specified location and save the scanned
images in this folder.
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■ External Program (Mail Program)

2

When scanning using the [OCR], [PDF], [Scan-1] or [Scan-2]
buttons, you can specify an application to be used to display the
scanned image. Click [Set] → select the application to use → click
[Open]. You can also specify an application by dragging and
dropping the application icon onto the dialog box.
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When scanning using the [Mail] button, you can specify an
e-mail software to which you want to attach the scanned image.
The MF Toolbox is compatible with e-mail software such as
Outlook Express, Microsoft Outlook, Microsoft Exchange,
EUDORA, Netscape Messenger and Windows Mail (Vista only).
Click [Set] → select the application to use → click [OK].
If [None (Attach Manually)] is displayed, you have to attach the
image file manually.

■ Confirmation of the Scanned Image and
Exif Settings (Confirm the Scanned
Image)
You can preview the scanned images as thumbnail images, and
specify the file type and location to save them.
NOTE

– You cannot use this function when scanning with the [OCR] button.
– For the [PDF] button, you can only confirm the scanned image and
specify the location to save the image.

Select [Confirmation of the Scanned Image and Exif Settings]
(for the [PDF] button, [Confirm the Scanned Image]) → click
[Start]. When the scanning is complete, the thumbnail of the
scanned image is displayed.
Confirm the thumbnail image → specify the file type and location
→ press [Save] or [Forward].
[Save as Type]

Specifies the file type to save the scanned
image. The available file types are the same
as those listed in “Save Scanned Image to,”
on p. 2-11.

[Exif Settings]

Opens the [Exif Settings] dialog box which
enables you to set the Exif information when
[JPEG/EXIF] is selected in [Save as Type]
(see “Exif Settings,” on p. 2-14).

[PDF Settings]

Opens the [PDF Settings] dialog box which
enables you to make advanced settings of
the PDF file (see “Creating One PDF File
from Two or More Pages,” on p. 2-16). This
button appears when [PDF], [PDF (Multiple
Pages)] or [PDF (Add Page)] is selected in
[Save as Type].

[Save Scanned Image to]
Specifies the location to save the scanned
image.
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[Add Scanned Image to]
This item appears instead of [Save Scanned
Image to] when [PDF (Add Page)] is
selected in [Save as Type]. You can select
the PDF file to which you want to add the
scanned image.
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[Save Pictures to a Subfolder with Current Date]

Appendix

Select this check box to create a folder with
current date in the specified location and
save the scanned images in this folder.
This check box is not available when [PDF
(Add Page)] is selected in [Save as Type].

4
[Save]

Press to save the scanned images in the
specified location.

[Forward]

This button appears instead of [Save] when
an application is specified in the [Mail
Program] or the [External Program] setting.
You can forward the scanned images to the
application.

[Cancel]

Cancels the operation and returns to the
previous window. Deletes all the images
scanned in the operation.

Exif Settings
You can attach extra information in the EXIF format, such as the
description of the image, the date when the image was
scanned, etc., to the JPEG files. Select a scanned image from
the drop-down list to view and add information for the image.
[Basic Information]
Displays the information automatically
acquired by scanning.
[Advanced Information]
Displays the extra information you enter.
[Apply the Same Setting of Input Items Automatically]
Select this check box to use the same values
you have specified in the previous scanning
operation.
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Scanning an Image from an Application
You can scan an image from a TWAIN- or WIA- (Windows
XP/Vista Only) compliant application and use the image in
that application. The following is an example of the
procedure.

1.

Set documents.

2.

Open the application you want to use.

3.

Select the command to scan.

4.

Select the scanner driver to be used.
With Windows XP/Vista, you can use the ScanGear MF or the
WIA driver as the scanner driver.

5.

Specify the scanner settings → click [Scan].
For details, see “Setting Preferences and Scanning with
ScanGear MF,” on p. 2-18, or “Scanning with the WIA Driver,” on
p. 2-40.
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Creating One PDF File from Two or More Pages
You can scan two or more pages and make them into one
PDF file.

Specify other required settings → click [PDF
Settings].
The [PDF Settings] dialog box appears.

1.

Set documents.

2.

Double-click the [Canon MF Toolbox 4.9] icon
on the Windows desktop to open the MF
Toolbox.

4

5.

You can also open the MF Toolbox by clicking [start] on the
Windows task bar → [(All) Programs] → [Canon] → [MF Toolbox
4.9] → [Toolbox 4.9].

3.

Click [PDF].

4.

Select [PDF (Multiple Pages)] in [Save as
Type].

6.

Specify the required settings → click [OK].
[Create Searchable PDF]: Converts the characters in the
document to text data and makes the PDF document searchable
with keywords.
[Text Language]: Select the language of the text to be scanned.
The characters may be recognized more accurately if you select
[English] from this drop-down list and set [Image Quality] to [300
dpi] or higher in [Scanner Settings] (see p. 2-11).
[PDF Compression]: Select [High] for color images such as
photos or illustrations to be further compressed, reducing the file
size.
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7.

Click [Start].
When you set the document on the platen glass, the following
dialog box appears as each page is scanned.
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To continue to scan, place the next page and click [Next]. When
scanning is completed, click [Finish].
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Setting Preferences and Scanning with
ScanGear MF
The ScanGear MF enables you to preview the image to be
scanned and make detailed adjustments for the image. To
use the ScanGear MF, select [Display the Scanner Driver] in
the MF Toolbox, or scan from an application.

■ Using Simple Mode

NOTE

You cannot preview the image when using the ADF.

■ Switching between Simple Mode and
Advanced Mode
The ScanGear MF has two modes: [Simple Mode] and
[Advanced Mode]. With [Advanced Mode] you can perform
detailed settings such as resolution and contrast.
To switch between two modes, click the corresponding tab.

1.

Set documents.
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2.

Select the document type in [Select Source].

5.

[Photo (Color)]: To scan color photos.

The options you can select vary depending on what you selected
in step 4.
Click
to switch the orientation of the output size (landscape or
portrait).

[Magazine (Color)]: To scan color magazines with the Descreen
function.

2

[Newspaper (B&W)]: To scan text and line drawings.

Troubleshooting

[Document (Grayscale)]: To scan color images or text in
monochrome. Appropriate for scanning high-resolution
monochrome images.

3
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6.

[Document (Color) ADF]: To scan color documents on the ADF.

4

NOTE

If you select [Document (Color) ADF] or [Document (Grayscale)
ADF], skip to step 4.

– The [Fading Correction] check box can be selected only when
scanning color documents.
– When the preview image is not displayed, the [Fading
Correction] check box is disabled.

NOTE

3.

Adjust the cropping frame and select the
[Fading Correction] check box as needed.
To adjust the cropping frame, click
(Auto Crop) or drag the
corner or edge of the frame. For details, see “Specifying the
Parameters of a Scan,” on p. 2-22.

[Document (Grayscale) ADF]: To scan Grayscale documents on
the ADF.

On how to turn off the automatic color correction for the
document type other than [Newspaper (B&W)], see “[Color
Settings] Tab,” on p. 2-37.

Select the output size of the scanned image
in [Output Size].

7.

Click [Scan].

Click [Preview].
A preview of the scanned image appears in the preview window.

4.

Select the use for the scanned image in
[Select Purpose].
You can select from [Print (300 dpi)], [Image display (150 dpi)], or
[OCR (300 dpi)], depending on the document type you selected
in step 2. For details, see “Determining Resolution,” on p. 2-39.
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Add/Delete the Output Size
Selecting [Add/Delete] for [Output Size] opens the [Add/Delete
the Output Size] dialog box. This dialog box enables you to add
and delete the custom output size.

3

[Add]

Adds the specified output size to the [Output
Size List].

[Delete]

Deletes the selected output size from the
[Output Size List].

[Save]

Saves added or deleted output sizes.

Simple Mode Toolbar
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(Auto Crop)

Crops the image automatically. For details,
see “Specifying the Parameters of a Scan,”
on p. 2-22.

(Remove Cropping Frame)
[Purpose]

Selects the use for the scanned image from
[Print] or [Image Display]. This setting is
available with [Advanced Mode] only.

[Output Size Name]
Specifies the output size name you want to
register.
[Width]

Specifies the width of the output size.

[Height]

Specifies the height of the output size.

[Unit]

Selects the unit of measurement for the
output size.

Removes the selected cropping frames.
(Left Rotate)

Rotates the image 90 degrees left.

(Right Rotate) Rotates the image 90 degrees right.
(Information)

Lists the scanning information.
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■ Using Advanced Mode

3.

Click [Preview].
NOTE

– Selecting the range in the preview window and clicking [Zoom]
reloads the selected image to be enlarged.
– To delete the displayed preview image, click
.

2

Troubleshooting

4.

3

If you want to scan only part of the
document, specify the parameters.
For details, see “Specifying the Parameters of a Scan,” on
p. 2-22.
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5.
1.

Set documents.

2.

Select settings for [Favorite Settings], [Input
Settings], [Output Settings] and [Image
Settings], and adjust the color settings.

Click [Scan].

For details on the settings, see “Advanced Mode Settings,” on
p. 2-24.
If you select [ADF (1-sided)] in [Original Input Method], skip to
step 4.
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Advanced Mode Toolbar
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[Zoom]

Troubleshooting

3
Appendix

[Select All Crops] When this button is used, all the cropping
frames reflect the settings made on the
[Advanced Mode] tab sheet.

(Clear)

Deletes the preview image from the preview
area. It also resets the toolbar settings and
color settings.

(Crop)

Specifies the parameter of a scan.

(Move)

Moves the enlarged image on the screen.

(Zoom)

Enlarges or reduces the preview image.
Click on the image to zoom in, and right-click
on the image to zoom out.

4

(Left Rotate) Rotates the image 90 degrees left.
(Right Rotate) Rotates the image 90 degrees right.
(Information) Lists the scanning information.
(Auto Crop)

Click this button to rescan the focal cropping
area of the preview image at a higher level of
magnification.
Once clicked, this button changes into
[Undo]. The image retunes to its original size
by clicking [Undo].

■ Specifying the Parameters of a Scan
You can create scan areas (cropping areas) for images shown in
the preview area. When you click [Scan], only the cropped area
will be scanned.

Selecting the Cropping Area Automatically
After previewing, click
(Auto Crop) on the toolbar. Clicking
this button enables you to gradually crop off the image outside
the borders detected in the preview image.

Crops the image automatically. For details,
see “Specifying the Parameters of a Scan,”
on p. 2-22.

(Remove Cropping Frame)
Removes the selected cropping frames.
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Creating a Cropping Frame
Select
(Crop) on the toolbar, click on the preview image and
drag over the area you wish to select. To make further
adjustments, drag the corner or edge of the selected frame or
enter the desired parameter values for
(Width) and
(Height) in [Input Settings] on the [Advanced Mode] tab
sheet. To move the cropping frame you have selected, click
inside the cropping frame and drag.

Deleting Cropping Frames
If you want to remove cropping frames, select the frame or
frames and do one of the following:
–
–
–
–

Click [Delete] on the keyboard.
Click
(Remove Cropping Frame) on the toolbar.
Right-click on the cropped area and select [Delete].
Hold down [Ctrl] on the keyboard, right-click outside the cropped
area, and select [Delete].

NOTE

– To maintain the current width and height proportion of the image,
click
in [Input Settings].
– When using the ADF, creating a new cropping frame will erase an
existing one.

Creating Multiple Cropping Frames (Only when
Using the Platen Glass)
You can create another cropping frame even if there is already
one in the preview area. Click and drag the mouse cursor
outside the existing cropping frame to create a new cropping
frame in that area.
You can create up to 10 cropping areas. By clicking [Scan] once,
all the cropped areas will be scanned. (Scanning will continue
until all selected areas have been scanned.)
The most recently created cropping frame will become the focal
point. To make adjustments to previously created cropping
frames, select the frame or frames by clicking on them.
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■ Advanced Mode Settings

Favorite Settings
Favorite Settings enables you to save a set of settings (Input
Settings, Output Settings, Image Settings, Color Settings and
Preferences) made for the focal cropping frame. If there are no
cropping frames, settings for the whole preview area are saved.
You can also recall the saved settings and apply them to the
selected frames or the whole preview area.
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NOTE

The following items cannot be saved in Favorite Settings:
– Values of
(Width) and
(Height) in [Input Settings] and in
[Output Settings]
– Activation of
button (maintaining the proportion of width and
height) in [Input Settings]
– Value of [%] (Scale) in [Output Settings]

[User Defined]

When this option is selected, specify a value
for each setting.

[Default]

Restores the default settings. The preview
image will be cleared.

[Add/Delete]

Opens the [Add/Delete Favorite Settings]
dialog box. This dialog box enables you to
name and register a set of settings for the
current preview image.
[Add/Delete] is not displayed when there is
no preview image.
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Input Settings
[Original Input Method]
Selects where the document is placed from
[Platen Glass] or [ADF (1-sided)].
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[Orientation]

(Width)

Specifies the width of the input size.

(Height)

Specifies the height of the input size.

NOTE

NOTE

If you change this setting after previewing, the preview image
will be deleted.

[Input Size]

Opens the [Orientation] dialog box. This
dialog box enables you to specify the
orientation of the original document.

Selects the size of the original document.

NOTE

– If you change this setting after previewing, the preview image
will be deleted.
– When the document is loaded in the ADF, select the paper size
from [A5 Portrait], [A5 Landscape], [A4], [Letter] and [Legal].

(Original Orientation)
Shows the direction of the document being
scanned. The icon display varies depending
on the settings for [Original Input Method],
[Input Size], and [Orientation].

– Some applications have a limit to the amount of image data
they can receive. If the parameters of a scan contain more than
21,000 x 30,000 pixels, the image will not be received.
– When [Output Resolution] is set to [600] dpi, minimum
parameters of an image are 96 x 96 pixels.
– To maintain the current width and height proportions of the
image, click .

[Color Mode]

Selects the type of document and the way in
which it is scanned.
[Black and White]:
To output documents to a monochrome
printer. The contrast in the image is divided
at certain levels (threshold values) into black
and white and is displayed in two colors. For
the threshold setting, see “Color Settings,”
on p. 2-29.
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[Grayscale]:
To scan black and white photos or
monochrome images. The image is
expressed in a 0-255 scale of black and
white.

[Output Size]

Selects the output size of the scanned
image. If you select [Add/Delete], the [Add/
Delete the Output Size] dialog box will
appear and you can add and delete the
custom output size (see p. 2-20).
If [Flexible] is selected, enter values in
(Width),
(Height) or [%] (Scale). The
resolution when you actually scan will
change in accordance with the value of [%].
The ratio of
(Width) and
(Height) is
linked to
(Width) and
(Height) in [Input
Settings]. You can enter the value for [%]
between 25 and 38400, but the upper limit
varies depending on the value of [Output
Resolution].
Click
to switch the orientation of the
output size (landscape or portrait). This
button is invalid when [Flexible] is selected.

[Data Size]

Shows the data size of the scanned image
according to your settings.

[Color]:
To scan color photos. The image is
expressed in 256 levels (8 bit) of R(ed),
G(reen) and B(lue).
[Color (Documents)]:
To scan color documents that include texts
or charts in addition to color photos. The
image is expressed in 256 levels (8 bit) of
R(ed), G(reen) and B(lue).
[Text Enhanced]:
To scan texts crisply, particularly to process
it with OCR software. The image is displayed
in black and white.

Output Settings
[Output Resolution]
Specifies the resolution for the scan. You
can select a resolution from the drop-down
list, or enter any value between 25-9600 dpi.
If you are using the ADF, enter a resolution
between 25-600 dpi. For details, see
“Determining Resolution,” on p. 2-39.
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[Reduce Dust and Scratches]
Reduces the dust and scratches on photos.
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[Auto Tone]
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Set to [ON] to automatically adjust the tone
of the image. You can apply this setting
when the preview image is displayed.

[None]:
No reduction of dust and scratches will be
made.
[Low]:
Reduces only small dust and scratch marks.

NOTE

This setting is available when [Color], [Color (Documents)] or
[Grayscale] is selected in [Color Mode], and [Color Correction] is
set to [Recommended] or [Color Matching] in the [Preferences]
dialog box (see p. 2-37).

[Unsharp Mask]

[Medium]:
Normally this setting is recommended.
[High]:
Reduces large dust and scratch marks.
This may remove delicate parts of the
image.

Set to [ON] to emphasize the outline of an
image and make it sharper. It is effective for
scanning photos etc., which have a soft
focus.
NOTE

NOTE

This setting is available when [Color], [Color (Documents)] or
[Grayscale] is selected in [Color Mode].

[Descreen]

This setting is available when [Color], [Color (Documents)] or
[Grayscale] is selected in [Color Mode].

Set to [ON] to reduce the distorted pattern
(moire) when scanning printed photographs
and pictures.

NOTE

– This setting is available when [Color], [Color (Documents)] or
[Grayscale] is selected in [Color Mode].
– Even if [Descreen] is set to [ON], some moire effect may remain
if [Unsharp Mask] is also set to [ON]. In this case, disable
[Unsharp Mask].
– A change in this setting is reflected after [Scan] is clicked.

Table of Contents
Index

2-27

TOP
Back

Previous

Next

Introduction

1
Scanning a
Document

[Fading Correction]
Rebuilds the color quality that has faded
over time. It also increases saturation of dullcolored originals to reproduce a vivid image.
You can apply this setting when the preview
image is displayed.
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[Grain Correction] Smoothes out the film grain of the image
recorded on fast film. The result is smoother
tones and higher overall quality.
[None]:
No grain correction will be made.

[None]:
No fading correction will be made.

[Low]:
Select this setting when the grain in the
picture is not so notable.

[Low]:
Corrects slightly faded images.

[Medium]:
Normally this setting is recommended.

[Medium]:
Normally this setting is recommended.

[High]:
Smoothes out even very notable grain in the
picture. This may lower the image sharpness
and tonal quality.

[High]:
Corrects highly faded images. This may
change the tone of the image.
NOTE

This setting is available when [Color] or [Color (Documents)] is
selected in [Color Mode], and [Color Correction] is set to
[Recommended] in the [Preferences] dialog box (see p. 2-37).

NOTE

– This setting is available when [Color], [Color (Documents)] or
[Grayscale] is selected in [Color Mode].
– This setting is not reflected in the preview image.
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Color Settings
Using Color Settings buttons, you can adjust the brightness and
contrast of the whole image, specify highlights and shadows,
and adjust the contrast and balance in an image.

● Brightness/Contrast
This dialog box enables you to adjust the levels of brightness
and contrast of the image.
Click
to adjust the brightness and contrast diagrammatically.

The buttons displayed differ depending on your selection in
[Color Mode]. When [Text Enhanced] is selected, no Color
Settings button is displayed.
When [Color], [Color (Documents)] or [Grayscale] is selected in
[Color Mode]:

When [Black and White] is selected in [Color Mode]:

By selecting [Add/Delete] from the drop-down list, you can name
and save a set of color settings. For details, see “Tone Curve/
Threshold Drop-Down List,” on p. 2-34.
Clicking a button opens the dialog box for each color setting.
If [Reset] is clicked, all color settings will be reset to the default
values.
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[Channel]
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Select a color to adjust either [Red], [Green],
or [Blue], or select [Master] to adjust all three
colors together when [Color] or [Color
(Documents)] is selected in [Color Mode].
Adjust the elements of grayscale when
[Grayscale] is selected in [Color Mode].

3

[Brightness]

4

Adjust the brightness of the image by
moving the slider
or entering values
(–127 to 127).

[Contrast]

Adjust the contrast of the image by moving
the slider
or entering values (–127 to
127).

[Reset]

Resets all the current settings to their default
values.

Appendix

● Histogram
This dialog box enables you to see the data concentration at
each brightness level in an image. You can specify the darkest
and brightest levels within an image, cut the levels and expand
the middle of the tonal range of the image.
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[Channel]

Select a color to adjust either [Red], [Green],
or [Blue], or select [Master] to adjust all three
colors together when [Color] or [Color
(Documents)] is selected in [Color Mode].
Adjust the elements of grayscale when
[Grayscale] is selected in [Color Mode].

(Gray Balance eyedropper tool)
When adjusting a color image, click this
button, then click a point in the preview
image (or inside the focal crop) to specify the
point to execute gray balance adjustment.
The gray elements within a scanned image
will appear as a neutral gray, and other
elements within the image will also have true
color reproduction.

(Black-point eyedropper tool)
Click this button, then click a point in the
preview image (or inside the focal crop) to
specify the darkest point. You can also enter
a value (0 to 245) or move the slider
to
an appropriate level.

[Reset]

Resets all the current settings to their default
values.

(Mid-point eyedropper tool)
Click this button, then click a point in the
preview image (or inside the focal crop) to
specify the midtone point. You can also enter
a value (5 to 250) or move the slider
to
an appropriate level.
(White-point eyedropper tool)
Click this button, then click a point in the
preview image (or inside the focal crop) to
specify the highlighted point. You can also
enter a value (10 to 255) or move the slider
to an appropriate level.
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● Tone Curve Settings

[Channel]

This dialog box enables you to adjust the brightness of a specific
area of an image by selecting the type of the tone curve. The
tone curve is a graph showing the balance of tone input and
output.

Troubleshooting

3

Select a color to adjust either [Red], [Green],
or [Blue], or select [Master] to adjust all three
colors together when [Color] or [Color
(Documents)] is selected in [Color Mode].
Adjust the elements of grayscale when
[Grayscale] is selected in [Color Mode].

[Select Tone Curve]
Select the tone curve from [No Correction],
[Over Exposure], [Under Exposure], [High
Contrast] or [Invert the Negative/Positive
Image].
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[Reset]

Resets all the current settings to their default
values.
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● Final Review

● Threshold

This dialog box enables you to confirm the color settings.

This dialog box enables you to adjust the threshold. By adjusting
the threshold, you can sharpen characters in a text document
and reduce back-printing such as in newspapers.
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[Threshold Level] Adjust the threshold by moving the slider
or entering a value (0 to 255).
[Reset]

Resets the current setting to the default
value.
NOTE

The brightness of color and grayscale images are expressed as a
value between 0 and 255 but the brightness of black and white
images is expressed in terms of either black or white, including
the parts of an image which are a color between the two. The
boundary at which black and white is divided is called “threshold”.

● Tone Curve/Threshold Drop-Down List
This drop-down list enables you to save a set of color settings
made for the focal cropping frame. If there are no cropping
frames, settings for the whole preview area are saved.
You can also recall the saved settings and apply them to the
selected frames or the whole preview area.
[Custom]

When this option is selected, specify a value
for each color setting. Even after the
registered settings are applied, [Custom]
resumes automatically if you change any
setting or make adjustments to the selected
cropping frame.

[Add/Delete]

Opens the [Add/Delete Tone Curve Settings]
dialog box ([Add/Delete Threshold Settings]
dialog box, when [Black and White] is
selected in [Color Mode]). This dialog box
enables you to name and register a set of
color settings.
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[Preferences] Dialog Box
Clicking [Preferences] on the [Advanced Mode] tab sheet opens
the [Preferences] dialog box. This dialog box enables you to
adjust settings for scanning and previewing.
● [Preview] Tab

[Preview at the Start of ScanGear]
Selects the preview operation when you
open the ScanGear MF.
[Automatically Execute Preview]:
The preview scan starts automatically when
you open the ScanGear MF.
[Display Saved Preview Image]:
Displays the image last previewed.
[None]:
Nothing is displayed.
[Cropping Frame on Previewed Images]
Sets how the cropping frame is displayed
when you preview images.
[Execute Auto Cropping on Previewed
Images]:
The image will be automatically cropped to
match the document size.
[Display the Last Frame on Previewed
Images]:
Displays the last frame.
[None]:
No frame will be displayed.
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● [Scan] Tab

[Color Mode (Text and Table)]:
The document is scanned in a mode
equivalent to [Color (Documents)] of [Color
Mode], regardless of the application
settings.

2

Troubleshooting

[Text Enhanced]:
The document is scanned in a mode
equivalent to [Text Enhanced] of [Color
Mode], regardless of the application
settings.
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[Automatically Quit ScanGear after Scanning]

[Scan without Using ScanGear’s Window]

If selected, the [ScanGear MF] dialog box
quits automatically after the image is
scanned.
Some applications will automatically quit
ScanGear MF after scanning irrespective of
this setting.

Enables you to scan in a specific color mode
when using an application that will not
display the [ScanGear MF] dialog box (such
as OCR software), overriding the application
settings.

Table of Contents
Index

2-36

TOP
Back

Previous

Next

Introduction

1
Scanning a
Document

● [Color Settings] Tab

[Color Matching]:
Select to automatically match the scanner,
monitor and color printer colors. If selected,
the Color Settings buttons are invalid in the
[Advanced Mode] tab sheet. This setting is
available when [Color] or [Color
(Documents)] is selected in [Color Mode].
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[None]:
No color matching is made. This setting is
available when [Color], [Color (Documents)]
or [Grayscale] is selected in [Color Mode].
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[Always Execute the Auto Tone]
If selected, the image color will always be
automatically corrected. This setting is
available when [Color], [Color (Documents)]
or [Grayscale] is selected in [Color Mode].

[Color Correction] Selects the type of color correction.
[Recommended]:
Vividly reproduces the tone of a document
on the screen.

[Monitor Gamma] Enables you to perform gamma correction.
Specify the gamma value (0.10 to 10.00) of
the monitor for viewing the scanned image.
This setting is not reflected in the scanning
result when [Black and White] is selected in
[Color Mode].
NOTE

[Monitor Gamma] value will be fixed to 1.80 when [Color
Matching] is selected in [Color Correction].
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● [Scanner] Tab

[Sound Settings]

2
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Sets the scanner to play music during
scanning or play a sound when scanning is
completed.
You can specify the following files: MIDI files
(∗.mid, ∗.rmi, ∗.midi), Audio files (∗.wav, ∗.aiff,
∗
.aif), MP3 file (∗.mp3).
[Play Music During Scanning]:
If selected, the scanner plays music during
scanning. Click [Browse], then specify a
sound file.
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[Play Sound When Scanning is Completed]:
If selected, the scanner plays sound when
scanning is completed. Click [Browse], then
specify a sound file.
[Test Scanner]
[Select Folder Where Temporary Files are Saved]
Click [Browse] and specify the folder in
which the files are saved.

Opens the [Scanner Diagnostics] dialog box,
which enables you to confirm normal
operation of the scanner. Check that the
power cord is plugged in, and the USB cable
is connected between the machine and your
computer, then click [Start].
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■ Determining Resolution

● Resolution and Data Size

The data in the image you scan is a collection of dots carrying
information about brightness and color. The density of these
dots is called “resolution” and “dpi” (dots per inch) refers to the
number of dots in one inch.
You can specify a resolution in [Image Quality] in the MF
Toolbox settings dialog box, or in [Output Resolution] in the
ScanGear MF.

If you double the resolution, the image data will be four times
greater. If the data is too large, processing speed will slow down
significantly, and you may experience malfunctions such as lack
of memory. Make sure the resolution corresponds to the
planned use of the image and set it at the lowest level possible.

● Images for Display on a Monitor
Images for display on a monitor in general should be scanned at
a resolution of 75 dpi.
● Images for Printing
Images to be printed should be scanned at a resolution which
corresponds to the resolution of the printer.
NOTE

With a color printer, the colors are expressed as a certain percentage of
ink pigment so scanning your document at half the resolution of the
printer should be fine.

● Printing Scale
For example, if you want to print a document which is twice the
original size both vertically and horizontally, the resolution of
your document will be reduced by half. In such a case, scan the
original document at double the resolution so that you can print
the document with sufficient quality, even if you double the size
of the document. Conversely, if you want to print a document at
a reduced size, it should be sufficient to scan at half the
resolution.
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Scanning with the WIA Driver
■ Scanning from the [Scanner and
Camera Wizard] Dialog Box (Windows
XP Only)

1.

4.

Select a picture type.

Open the [Scanners and Cameras] folder.
Click [start] on the Windows task bar → select [Control Panel] →
[Printers and Other Hardware] → [Scanners and Cameras].

2.

Double-click the corresponding WIA driver
icon.

3.

Click [Next >].
You can select from [Color picture], [Grayscale picture], [Black
and white picture or text], and [Custom].
When selecting [Custom], click [Custom settings] to make
detailed settings in the [Properties] dialog box.
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8.

Specify a name, a file format, and the location
for saving the group of pictures.
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5.

Select the paper source.
You can select from [Flatbed] or [Document Feeder].

6.

Specify the scanned area.
If you have selected [Flatbed] as the paper source, click [Preview]
→ drag
to specify the scanned area.
If you have selected [Document Feeder] as the paper source,
select the page size from the drop-down list.

7.

NOTE

– When you save more than one picture in the same location,
sequential numbers are automatically added at the ends of file
names.
– You can select a file format from [BMP (Bitmap Image)], [JPG
(JPEG Image)], [TIF (TIF Image)], and [PNG (PNG Image)].

Click [Next >].

Table of Contents
Index

2-41

TOP
Back

Previous

Next

Introduction

1
Scanning a
Document

9.

Click [Next >] to start scanning.

10. Click [Next >].

2
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If you want to publish these pictures to a Web site or order
printouts online, select the corresponding option.

11. Click [Finish].
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■ Scanning from the [Windows FAX &
Scan] Dialog Box (Windows Vista Only)

2

Depending on the edition of your Windows Vista, this function
may not be supported.

Troubleshooting

3

1.

Click [Start] on the Windows task bar → select [Control Panel] →
[Hardware and Sounds] → [Scan a document or picture] in
[Scanners and Cameras].
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Open the [Windows FAX & Scan] dialog box.

2.

Click [New Scan] to open the [New Scan]
dialog box.

4.

Specify required scan settings.
For details on the settings, see “[New Scan] Dialog Box,” on
p. 2-45.

5.

Click [Scan].
It starts scanning. Scanned image displays on [Windows Fax &
Scan].
When you scan more than one picture, sequential numbers are
automatically added to the file names and the image files are
saved in the [Scanned Documents] folder in the [Document]
folder.
Renaming the image file is available afterward.

You can open it also from the [File] menu by selecting [New] →
[Scan].

3.

Make sure the corresponding scanner driver
icon is displayed on [Scanner].
If you want to use other scanners, click [Change...] and select a
desired scanner driver icon.
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■ Scan from Windows Photo Gallery
(Windows Vista Only)

2

1.
2.
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Click [Scan].

Open the [Windows Photo Gallery].
Click [Start] on the Windows task bar → select [All programs] →
[Windows Photo Gallery].

Troubleshooting

3

6.

Open the [Import Pictures and Videos] dialog
box.
You can classify the scanned image by typing a tag in [Tag these
pictures (optional):].
If you save the scanned image without typing the tag, it will be
saved in a new folder created under the [pictures] folder, named
by its scan date.

Select [Import from Camera or Scanner] from the [File] menu.

3.

Double-click the corresponding scanner
driver icon.
Or select a corresponding scanner driver icon then press
[Import].

4.

Make sure the corresponding scanner driver
is displayed on [Scanner].

7.

Click [import].
When you save more than one picture, sequential numbers are
automatically added to the file names.
Renaming the image file is available afterward.

If you want to use other scanners, click [Change...] and select a
desired scanner driver icon.

5.

Specify required scan settings.
For details on the settings, see “[New Scan] Dialog Box,” on
p. 2-45.
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■ [New Scan] Dialog Box

[Source]

Selects from [Flatbed] (Platen glass) or
[Feeder (Scan one side)].

You can specify detailed settings for each scan.

2

NOTE

If you have selected [Flatbed] as the paper source, click [Preview]
→ drag to specify the scanned area. If you have selected [Feeder
(Scan one side)] as the paper source, select the page size from
the [Paper size].
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[Scanner]

The corresponding scanner driver is
displayed. Click [Change...] to select a
desired scanner driver icon.

[Profile]

Selects the use for the scanned image from
[Add profile…], [Last used settings],
[Document], and [Photo (Default)].

[Color format]

Selects the scanning color type from [Color
picture], [Grayscale picture], or [Black and
white picture or text].

[File type]

Selects a file format from [BMP (Bitmap
Image)], [JPG (JPEG Image)], [TIF (TIF
Image)], and [PNG (PNG Image)].

[Resolution (DPI)] Selects the scanning resolution in dot per
inch (50 to 600).
[Brightness]

Specifies the brightness (-100 to 100).

[Contrast]

Specifies the contrast (-100 to 100) (only for
color or grayscale scanning).

NOTE

– If you select [Last used settings], the settings previously used
are recalled.
– If you select [Add profile...], you can save new profiles from the
[Add New Profile] dialog box.
– To delete or edit added profiles, click [Delete] or [Edit] in the
[Scan Profiles] dialog box in the [Scanners and Cameras]
folder.
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■ Scanning from an Application
(Windows XP/Vista Only)

2

With the WIA driver dialog box open, follow the procedure
below. On how to display the WIA driver, see “Scanning an
Image from an Application,” on p. 2-15.

Troubleshooting

3

3.

The [Advanced Properties] dialog box appears.

4.

Adjust the quality of the image → click [OK].
For details on the settings, see “Advanced Properties,” on
p. 2-47.

5.

Appendix

If necessary, click [Adjust the quality of the
scanned picture].

Specify the scanned area.
If you have selected [Flatbed] as the paper source, click [Preview]
→ drag
to specify the scanned area.
If you have selected [Document Feeder] as the paper source,
select the page size in [Page size].

4
6.

1.

Click [Scan].

Select the paper source.
You can select from [Flatbed] or [Document Feeder].

2.

Select the picture type.
You can select from [Color picture], [Grayscale picture], [Black
and white picture or text], and [Custom Settings].
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Advanced Properties

2

[Picture type]

Selects the scanning color type ([Color
picture], [Grayscale picture], or [Black and
white picture or text]).

[Reset]

Resets all the current settings to their default
values.

Troubleshooting
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NOTE

The setting items and default values in the [Advanced Properties] tab
vary depending on the type of picture you select.
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[Appearance]

Shows the preview of sample image.

[Brightness]

Specifies the brightness (–127 to 127).

[Contrast]

Specifies the contrast (–127 to 127) (only for
color or grayscale scanning).

[Resolution (DPI)] Selects the scanning resolution in dot per
inch (50 to 600).
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Scanning Problems

2

Cannot scan a document.

Q

Is your USB hub or repeater working properly?

A

When using a USB hub or repeater, try connecting
a USB cable directly to the computer to check if it
works properly. If you can scan the document
successfully after connecting a USB cable directly
to the computer, check your USB hub or repeater if
it is working properly.
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Q

Is there anything displayed on the LCD?

A

If anything is displayed on the LCD, see Chapter
10, “Troubleshooting,” in the Reference Guide.

Q

Is the Error indicator blinking?

A

If the Error indicator is blinking, see Chapter 10,
“Troubleshooting,” in the Reference Guide.

Q

Is the document placed correctly?

A

Remove the document and place it on the platen
glass or in the ADF correctly. (See Chapter 2,
“Document and Paper,” in the Basic Operation
Guide.)

Q

Is your computer working properly?

A

Restart your computer.

4
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Q

Are you using a USB 2.0-compatible USB hub?

A

If you connect the machine to a USB 2.0-equipped
computer using a USB 2.0-compatible USB hub,
you may not be able to scan. In this case, connect
a USB cable directly to the computer.
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A

If you connect the machine to a USB 2.0-equipped
computer, you may not be able to scan. If your PC
is equipped with two or more USB ports, try
connecting the machine to another USB port. If the
problem persists, follow the procedure below to
modify the INI file. It is recommended to make a
backup copy of the file before making any changes
to it.
1. Open the following file in Notepad or another text
editor application.
Windows 98/Me:
windows\system\CNCMFP30.INI
Windows 2000:
winnt\system32\CNCMFP30.INI
Windows XP/Vista:
windows\system32\CNCMFP30.INI
2. In the [ScanSize] section, change
“Read512Bytes=0” to “Read512Bytes=1,” then
save the file. Take care not to modify any other
parts.

Q

Have you specified the document source
correctly with the MF Toolbox, ScanGear MF, or
WIA driver?

A

Choose between placing the document on the
platen glass or in the ADF.

Q

After installing the software for this machine,
did you install a TWAIN-compatible
application?

A

The TWAIN system file is replaced with something
inappropriate and you will be unable to scan
images. If this happens, remove the software, then
reinstall it. (See “Installing/Uninstalling Software,” in
the Starter Guide.)
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Q

Is the machine recognized in [Scanners and
Cameras]?

2

A

Make sure the corresponding scanner driver icon is
displayed in [Scanners and Cameras].
1. Click [start] on the Windows task bar → select
[Control Panel] → [Printers and other Hardware]
→ [Scanners and Cameras]. (Windows Vista:
[start] → [Control Panel] → [Hardware and
Sound] → [Scanners and Cameras]. Windows
98/Me/2000: [Start] → [Settings] → [Control
Panel] → double-click [Scanners and Cameras].)
2. If the corresponding scanner driver icon is
displayed in the [Scanners and Cameras], the
machine is recognized. If not, remove the
software, then reinstall it. (See “Installing/
Uninstalling Software,” in the Starter Guide.)
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You tried to create a multipage PDF, but were not able to scan
several documents.
Q

A

Is the [Automatically Quit ScanGear after
Scanning] check box in [Preferences] selected?
If you scan with the [Automatically Quit ScanGear
after Scanning] setting selected, only the
documents placed at one time on the platen glass
will be scanned.
Click a button on the MF Toolbox and, in the
settings dialog box, select [Display the Scanner
Driver] to open the ScanGear MF. In the
[Preferences] dialog box of Advanced Mode, clear
the [Automatically Quit ScanGear after Scanning]
check box before scanning.

Computer has hung up or frozen.
Q

Is enough memory loaded in your computer?

A

Quit other opened applications and try again.

Q

Is enough space available in the hard disk?

A

Check that the hard disk has enough available
space, in particular when scanning large
documents at a high resolution. For example, a
LTR-size document scanned at 600 dpi, full color
requires a minimum of 300 MB of disk space.

Q

When an error occurred during scanning an
image in Photoshop.

A

Change the allocated memory in Photoshop. From
the [Edit] menu, select [Preferences] → click
[Memory & Image Cache]. Change the [Memory
Usage] in a range of approximately 50% to 60%.

Q

Is the driver installed properly?

A

Remove the software, then reinstall it. (See
“Installing/Uninstalling Software,” in the Starter
Guide.)
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You installed the applications in the CD-ROM supplied with the
machine but they are not registered in the MF Toolbox.
Q

Have you installed the applications with the MF
Toolbox open?

A

If you install the applications with the MF Toolbox
open, the applications will not be registered in the
MF Toolbox. On the MF Toolbox dialog box, click
[Set] to register the application manually. (See
“External Program (Mail Program),” on p. 2-13.)
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Changed settings in a dialog box are not activated.
Q

Did you restart your computer after changing
the settings?

A

If you open [Scanners and Cameras] and change
the settings in the [Events] tab, the changes may
not be reflected. In this case, restart your
computer.

When you click a button on the MF Toolbox, another application
opens.
Q

Is the application selected correctly for that
button?

A

Click a button on the MF Toolbox and select the
application you want to open for that button. (See
“External Program (Mail Program),” on p. 2-13.)
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Scanned images look dirty.
Q

Are the scanning components of the machine
clean?

A

Clean the platen glass, the platen glass cover and
the ADF scanning area.

Q

Is the image size too small?

A

Some applications do not display an image
properly at small sizes. Try displaying the image at
100% magnification.

Scanned image is displayed at a larger (smaller) size on the
computer screen.
Q

Is the resolution setting correct?

A

Do one of the following:
– Enlarge or reduce the image display in the
application. If you open the image in Paint or
Imaging, it may display at a large size and you
will not be able to reduce it.
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Q

Is the monitor's display color set below 16 bits?

A

In [Display Properties], set the display colors to
16-bit color, 24-bit color or higher.

– Change the resolution and scan again.
The image will be large if the resolution is high. It
will be small if the resolution is low. (See
“Determining Resolution,” on p. 2-39.)
Cannot scan highlighted marks.
Q

Is [Color Correction] set to [Color Matching] ?

A

In [Advanced Mode] in ScanGear MF, set [Color
Correction] to [Color Matching]. (See “[Color
Settings] Tab,” on p. 2-37.)
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Cannot install the software.
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Q

4

A
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Removal of the software was completed, but the [Canon] folder
remains in the [Start Menu].

Have you followed the instructions to install the
software?

Q

Did you remove the MF drivers before removing
the MF Toolbox?

Try reinstalling the software. If an error occurred
and installation was not complete, restart your
computer and try reinstalling the software.

A

If you remove the MF drivers first, the [Canon]
folder may remain even after the MF Toolbox is
uninstalled. In this case, perform the following
steps to remove the folder.
In Windows XP, right-click the [start] menu to open
the Windows Explorer → select [Start Menu] in [All
Users] → [Programs] → delete the [Canon] folder.
In Windows Vista, right-click the [start] menu and
select [Explore - All Users] → select [Start Menu] in
[All Users] → [Programs] → delete the [Canon]
folder.
In Windows 2000, open [Settings] from the [Start]
menu → click [Taskbar & Start Menu] →
[Advanced] → [Advanced] → select [Start Menu] in
[All Users] → [Programs] → delete the [Canon]
folder.
In Windows 98/Me, open [Settings] from the [Start]
menu → click [Taskbar & Start Menu] → [Start
Menu Programs] → [Remove] → select the
[Canon] folder → click [Remove].

Q

Are any other applications open?

A

Quit all of these and try reinstalling the software.

Removal of the drivers takes too long (Windows XP).
Q

Is any application such as an anti-virus open
when removing the software?

A

Quit any applications (including anti-virus) before
removing the software.
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The message <Version conflict> appears on your computer
(Windows 98).
Q

When Photoshop has installed on your
computer.

A

If photoshop is installed on your computer,
messages <Version conflict> or <Windows 98 file
language or ...> may appear during the installation.
In this case, click [YES] or [No]. Whichever you
click, installation thereafter will continue troublefree.
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Cannot use the software after upgrading to Windows XP/Vista.
Q

Have you upgraded Windows 98/Me/2000 to
Windows XP/Vista without removing the
software?

A

Remove the software, then reinstall it. (See
“Installing/Uninstalling Software,” in the Starter
Guide.)

In [Device Manager], green mark “?” is displayed (Windows Me).
Q

Is green mark “?” displayed on [USB
Composite Device] in [USB (Universal Serial
Bus) Controller] in [Device Manager] in
Windows Me?

A

As this is not a problem, you can continue to use it
as is.
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Scanner Specifications
Type

Color scanner

Max Scanning Size

8 ½" x 14" (216 mm x 356 mm)

Scanning Resolution

600 x 1200 dpi (optical)
9600 x 9600 dpi (enhanced)

Scanning Speed

Color: 4.5 msec/line (600 dpi)
Grayscale: 1.5 msec/line (600 dpi)

Host Interface

USB 1.1, USB 2.0
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System Requirements Windows 98/98SE/Me/
2000 Professional/XP
Windows Vista
Device Driver

TWAIN and WIA (Windows XP/
Windows Vista only) compliant

NOTE

Specifications are subject to change without notice.
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Application

3

Abbreviation of the phrase “application software.” Software
designed for a specific purpose such as word processing
software, spreadsheet software, database software, or a
combination of these.
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B

Color Matching
In some cases, the range of colors captured by a scanner
exceeds the range that can be displayed by a particular monitor.
In addition, the colors displayed for an image on the monitor may
be slightly different than those output by a printer. Color Matching
is the process used to make the colors captured by a scanner
consistent with those shown on a display or printed on a printer.

Contrast

Bit
An indication of the volume of data used to describe points in an
image. A 1-bit image assigns image data black or white color
values depending on whether the brightness value is above or
below a particular threshold value. The result is a two-color
image. An 8-bit grayscale image expresses an image in 256
shades of gray ranging from white to black. A 24-bit color image
assigns 8 bits to each RGB color channel, expressing each pixel
in approximately 16.8 million colors.

Brightness
The relative proportion of light and dark areas. Decreasing
brightness darkens the overall image; increasing brightness
lightens it.

The degree of difference between the lightest and darkest areas
of an image. Decreasing contrast lightens the dark areas and
darkens the light areas; increasing it darkens the dark areas and
lightens the light areas.

Control Panel
The set of Windows programs you can use to change system,
hardware, software, and Windows settings.

Crop
The action of selecting only part of an image for use. Using the
Crop button on the ScanGear MF toolbar, a portion of the preview
image can be selected and only that portion is then re-previewed
or included in the final scan.
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E
Default setting

2

A setting that is automatically used if no other setting is specified.
A function that reduces the occurrence of moire in the scan of a
printed item. Moire is the patterns or stripes that are visible in a
low-resolution scan of a picture or photo in a book or magazine
due to the interference patterns between the dots that comprise
the image.

3
4

The Exchangeable Image File (Exif) format is a Japan Electronic
Industry Development Association (JEIDA) standard used by
most digital cameras to store images. The Exif compressed files
use the baseline JPEG format, so they can be read by any
application supporting “JPEG.” EXIF supports the storage of extra
information, such as the date & time the image was taken,
exposure information, etc., within the header of each JPEG file.

Descreen

Troubleshooting
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Exif

Desktop
The entire Windows screen that represents your work area in
Windows. Icons, windows, and the taskbar are displayed on the
Windows desktop.

Dot

F
Folder
A container in which documents, program files, and other folders
are stored on your disks. Formerly referred to as a directory.

Images are reproduced as rows and columns of dots. When an
item is scanned with a scanner, the resolution, or dot density, of
the scanned image is measured as the number of dots per inch
(dpi).

dpi
Dots per inch. A unit of measurement for indicating a machine’s
resolution.

Driver
A program that controls how the computer and an external device
interact. For example, the scanner driver supplies OS with
information and features of the installed scanner. See also
Scanner driver.
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L
Gamma Correction
Method for changing the brightness of an image. With gamma
correction, the brightness of parts of an image in the middle of the
tonal range is changed without changing the lightest or darkest
areas of the image, which means you can change the brightness
of an image while maintaining contrast.

2

Troubleshooting

3

A horizontal scanning orientation. Documents are scanned
across the longer axis of the page.

M
Megabyte (MB)

Grayscale image

A unit of measurement, representing one million bytes, used to
describe machine or computer memory size.

A bitmap image that stores data for each dot as a shade of gray,
rather than as black or white.
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Landscape

Multipage PDF

I

Several scanned documents saved as one PDF. Each document
will become one page of the PDF.

Install

My Computer

To copy software to a designated location on a computer’s hard
disk so that it can be used at any time.

The Windows program that you can use to browse through your
computer’s filing system, and to open drives, folders, and files.
You can also use [My Computer] to manage your files and your
filing system, by moving, copying, renaming, and deleting items.

Interface
The connection between two devices through which they
communicate with each other. The machine features a USB
interface, which makes it compatible with IBM and similar
personal computers.

N
Network

K
Kilobyte (KB)

A group of computers connected by cables or other means and
using software that enables them to share equipment (such as
printers) and exchange information.

A unit of measurement, representing the binary number 1024,
used to describe machine or computer memory size in thousandbyte units.
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Preview
OCR (Optical Character Reader)
Device for reading characters optically. System for extracting
information in a text format from information in the form of a
graphic such as hand-written or printed characters which have
been scanned with a scanner. You cannot edit text scanned with a
scanner because it is in a graphic format, but with OCR software
you can convert to a text file and then edit the text with wordprocessing software.

2
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Orientation

4

The direction in which a document is fed, either along the width
(portrait) or length (landscape) of the page.

P

Provisional scanning and display of the document you are about
to scan before you actually scan it. If the preview scan looks
different from what you want, you can change the settings, display
the preview again and confirm before scanning.

Preview area
The area at the left of the ScanGear MF main window. When the
Preview button is clicked, the item(s) on the platen glass of the
scanner are scanned, and the results are displayed as the
preview image in this area. At this stage, the scanned image is
not passed on to the host application program.

Properties dialog box
The dialog box that contains information about a particular
device, such as a scanner.

PDF
Stands for Portable Document Format. A widely used format for
transmitting and viewing documents on computers. PDF
documents can be read or printed out with Adobe’s Acrobat
Reader program.

Pixel
Short for picture element, a pixel is the smallest unit used to
measure a display image.

Platen
The document scanning unit.

Portrait
A vertical scanning orientation. Documents are scanned across
the shorter axis of the page.
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Random Access Memory (RAM)
The working memory of the computer in which programs and data
are temporarily stored while you use them. Resetting or shutting
off the computer clears all information from RAM. Printing very
complicated documents might require closing other running
programs or adding more RAM to the computer.

2

Troubleshooting

3

Reinstall
To remove installed software and install again.
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Resolution

4

The density of dots for any given output device, expressed in
terms of dots per inch (dpi). Low resolution causes font
characters and graphics to have a jagged appearance, but prints
faster than higher resolutions. Higher resolution provides
smoother curves and angles as well as a better match to
traditional typeface designs, but prints more slowly. Resolution
values are represented by horizontal data and vertical data, for
example, 600 x 600 dpi.

TWAIN
Industry-standard protocol for transferring information from
devices such as scanners and digital cameras to a computer.
Industry-standard protocol for an application programming
interface (API) for input devices such as scanners. If both the
device and the application comply with the standard, they will be
compatible regardless of differences in manufacturer or model.
For example, with TWAIN-compatible image-processing software,
you can start the scanner’s TWAIN driver from the software’s
menu, scan the document and return the scanned image to its
original image-processing software.

S
Scanner driver
A program that controls how the computer and scanner interact.
The scanner driver is provided with two drivers: The TWAIN and
the WIA driver (for use with Windows XP/Vista).

Scanners and Cameras folder (Scanners and Cameras
Properties dialog box)
The folder or dialog box that contains information about your
imaging devices, such as scanners or cameras.
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Uninstall
To remove software installed on a computer and return the
computer to its condition before the software was installed.

2

Universal Serial Bus (USB) interface

Troubleshooting

These are new serial interface standards. This bus automatically
recognizes connections (Plug and Play) to allow plugging and
unplugging connectors with the power still turned on to the PC or
peripheral equipment.

3
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W
WIA (Windows Image Acquisition)
Standard for downloading images from scanners or digital
cameras. The machine includes a TWAIN-compliant driver and a
WIA-compliant driver. The WIA driver can only be used with
Windows XP/Vista. With either driver, you can scan documents
with the machine in applications which support the TWAIN
interface (Photoshop etc.).

Windows Explorer
The Windows program you can use to browse through, open, and
manage the disk drives, folders, and files on your computer in a
network system. You can also use Windows Explorer to view and
open shared folders on other computers on the network. You can
use Windows Explorer to manage your files by moving, copying,
renaming, and deleting files.
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Add/Delete the Output Size dialog box 2-20

Fading Correction 2-28

Orientation 2-10

Advanced Mode

Favorite Settings 2-24

Output Settings 2-26
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settings 2-24
switching 2-18
toolbar 2-22
using 2-21
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Advanced Properties dialog box 2-47
Application 2-15
Auto Tone 2-27

B
Brightness 2-29

Final Review 2-33

P
G

Parameters of a scan
specifying 2-22

Gamma 2-37
Grain Correction 2-28

PDF Setting dialog box 2-16
Preferences dialog box 2-35

H

Preview tab 2-35

Histogram 2-30

Problems
installing and uninstalling 3-7
scanning 3-2

I
Image Settings 2-27

C
Cannot install 3-7
Color Matching 2-37
Color Settings 2-29
Color Settings tab 2-37

Input Settings 2-25

R

Installing and uninstalling problems 3-7

Reduce Dust and Scratches 2-27
Resolution

M
MF Toolbox

Contrast 2-29

Save Scanned Image to 2-11
scanner settings 2-9
settings 2-9
using 2-7

Crop 2-22

D
Descreen 2-27
Driver
checking installation 1-4

determining 2-39
DPI 2-47
output 2-26

Multiple PDF 2-16

N
New Scan Dialog Box 2-45
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S

T

Scan tab 2-36

Threshold 2-33

ScanGear MF

Tone Curve 2-32

Advanced Mode 2-21
setting 2-18
Simple Mode 2-18
Scanner and Camera Wizard 2-40

Tone Curve/Threshold drop-down list 2-34
Troubleshooting 3-1
TWAIN driver 2-15

Scanner tab 2-38

U

Scanning 2-1

Unsharp Mask 2-27

from an application 2-15, 2-46
New Scan Dialog Box 2-45
problems 3-2
setting 2-5
using MF Toolbox 2-7
Windows FAX & Scan 2-43
Windows Photo Gallery 2-44
with [Start] on the machine 2-3
Setting the scanning function for [Start]
in the [Scanners and Cameras] folder 2-5
in the [Settings] dialog box 2-5
on the MF Toolbox main window 2-4

V
Version conflict 3-8

W
WIA driver 2-15, 2-40
Windows FAX & Scan 2-43
Windows Photo Gallery 2-44
Windows FAX & Scan 2-43
Windows Photo Gallery 2-44

Simple Mode
switching 2-18
toolbar 2-20
using 2-18
Software
checking installation 1-4
problems during installing and
uninstalling 3-7
Specifications
scanner 4-2
System requirements 1-3
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